
                                                                        

                                                                                     Assignment - 1 

                                          Topic :- CCA 101 Fundamentals of IT & programming                    

 Q. 1. What are the four fundamental parts of computer ? Explain it with the help of digram.   

 Answer :-  Four fundamental parts of computer are:-  

                  :- Input unit , CPU ,  Primary memory , and output unit are the 

                                                                                                                                                   

                                                           
                      Four basic components of a computer system.  

Explain :- A Computer has four main components input units , the central  

                  Processing unit or CPU,the primary memory , and output units. 

✓ Input unit -  The devices to input information, such as a keyword, and mouse . 

✓ CPU – The CPU is further broken up into ALU, Control Unit, And Instrucation Unit .  

✓ Primary Memory – Computer program instructions converted into machine code are stored in 

primary storage or memory . 

✓ Output Unit – The devices to output information, such as a Printer, moniter, and speaker. 

Q.2. Discuss about the classification of computer based on size and capacity.  

Answer:-  

Introduction:-  Classification of computers are based on their architecture, speed of executing commands or 

instructions, peripheral used and also their uses. Microcomputers are usually used in home and offices and 

only a single user can perform the task using a microcomputer. Its storage and data handling capacity are 

limited as per the requirement for home and office work. The another type of computer is called 

minicomputer which has usually larger storage and can handle multiuser at a time. This chapter includes the 

classification of computers. 

Computer's Classification:- Computers are classified on different parameters, such as, storage capacity, 
processing speed and component (CPU) used in computers. Depending upon the components used and features 
of different computers, they are classified into four groups, Microcomputers, Minicomputers, Mainframe 
computers and Supercomputers. 
Micro Computers:- Micro Computer is a computer whose CPU (Central Processing Unit) is a microprocessor. All 
the components of a microprocessor are on a single integrated circuit chip. Micro computer can be categorized 
as the desktop, programmable and workstation. The microprocessor based computers are called third 
generation computers. They are the backbone of the modern computer era. The first and second generation 
computers are based on vacuum tubes and bipolar junction transistors. 
Desktop Computers:- Desktop computer is a type of microcomputer. A desktop computer has a keyboard for 
input data, a LCD or CRT monitor to display information and Central processing unit tower contains storage, 
memory, different types of drives, such as, CD drive, hard drive, etc. A desktop computer is mainly used at home 
and office applications. 



                                                                        

Programmable Computers (PDA):-  Personal digital assistance is a type of hand held programmable digital 
computer. It is used as notepads, address books and can connect to world web wave to share information. A 
PDA is equipped with mobile phone hence, called smallest computer. 
Workstation:- A workstation computer has greater memory capability and more extensive mathematical 
abilities. It is connected with other workstation computers or personal computer to exchange data and mostly 
used for scientific applications. It also supports multitasking applications. 
Mini Computers:- Minicomputers were introduced in early 1960s. They were faster than micro computers. 
Basically these computers were mainly multi-user systems, where many users work on the systems. Generally 
these types of computers had larger memories and greater storage capacity. They had large instruction set and 
address field. These kinds of computers have efficient storage for handling of text, in comparison to lower bit 
machines. Due to more efficient processor, speed and memory size, minicomputer was used in variety of 
applications and could support business applications along with the scientific applications. Minicomputer was a 
multi-user system which means more than one user could use this system simultaneously. 
Comparison of Micro and Mini computers 
  

Features Microcomputer Minicomputer 

Primary 
memory  

Shall memory Larger memory 

Word length  Small word length  Larger word length 

Cost low Low High 

Processor Low High 

Mainframe Computers 
Mainframe computers are large and expensive machines. The word length of mainframe computers may be 48, 
60 or 64 bits, memory capacity being in some megabytes and storage capacity in some terabytes. Generally they 
handle huge volumes of information and data. In terms of speed, they are having significant processing capacity. 
They are used in research organizations, large industries, airlines reservation where a large database has to be 
maintained.  

 

Super Computers 
Super Computers are the fastest computer in current era. The processing capabilities of super computer lies in 
the range of GIPS2, word length 64-128 or may be in 256 or so. The memory capacity of super computer is in 
some gigabytes or in terabytes. The storage capacity of this type of computer is in exabytes. 

  



                                                                        

 

   

 The parallel processing of a super computer makes it very fast because it contains number of CPU that 
operates parallel. 

They  are used at some research centers and government agencies involving sophisticated scientific and 
engineering  tasks. 

   Super computers are used for the followings: 
  Weapons research and development 
  Nuclear and plasma physics 
  Rocket research and development 
  Atomic research 
  Aerodynamics 

Units For Measuring Word Length, Data, And Storage Capacity of a Computer 
Computers are classified on the basis of their data processing speed better known as clock speed and the word 
length. The word length that is processed by a CUP at a time is one of the important feature of that CPU. 
The followings are the units for the measurement of data volume: 

bit bit 0 or 1 

Byte B 8 bite 

Kibibit Kibit 1024 bits 

kilobit Kbit 1000 bits 

kibibyte (binary) KiB 1024 bytes 

kilobyte (decimal) kB 1000 bytes 

megabit Mbit 1000 kilobits 

mebibyte (binary) MiB 1024 kibibytes 

megabyte (decimal) MB 1000 kilobytes 

gigabit Gbit 1000 megabits 

gibibyte (binary) Gibbs 1024 mebibytes 

gigabyte (decimal) GB 1000 megabytes 

terabit Tbit 1000 gigabits 

tebibyte (binary) TIB 1024 gibibytes 

terabyte (decimal) TB 1000 gigabyte 

Petabit Pbit 1000 terabyte  



                                                                        

pebibyte (binary) PiB 1024 tebibytes 

petabyte (decimal) PB 1000 terabytes 

exabit Ebit 1000 petabits 

exbibyte (binary) EiB 1024 pebibytes 

exabyte (decimal) EB 1000 petabytes 

Q.3. What is the meaning of computer generation?  How many Computer Generation  are defined? What 
technologies were/are used? 
Answer :-  Generation in computer terminology is a change in technology a computer is/was being used. 
Initially, the generation term was used to distinguish between varying hardware technologies. Nowadays, 
generation includes both hardware and software, which together make up an entire computer system. 

                                                    GENERATION OF COMPUTER 

➢ First generation-1942-1955 

➢ Second generation-1955-1964 

➢ Third generation-1964-1975 

➢ Fourth generation-1975-1989 

➢ Fifth generation-1989-Now 

➢ First Generation:- 

 

In this generation was used of vacuum tubes .in this computer used of machine language.and punch card 

was used for storage the data. 

Ex-ENIAC,MARK-1 & Univac-1 etc. 

➢ Second Generation:- 

 

In this generations computer used of Transistor replaced by Vacuum tubes.in the computer used of 

magnetic core used for storage the data.in during of second generation begin the use of computer in 

business world.and developed new programming language. 

➢ Third Generation:- 

 

In the computer of this generation was used IC(integrated circuit)replaced by Transistor,which was 

developed by J.S.Kilbi.in the beginning LSI(large scale integration)was used on a silicon chip of IC and 

computer become faster to used for RAM(Random access memory). 

➢ Fourth Generation:- 



                                                                        

 

VLSI(very large scale integration) & ULSI(ultra large scale integration)used replaced by IC(integrated 

circuit).Increase the capacity of RAM & save the time.computer become very fast –MsDos,Ms-

Windows,Applemacos (operating system/software)  & C Programming language developed. 

➢ Fifth Generation:- 

 
ULSI developed replaced by VLSI & ULSI maybe in caroers calculations through a chip.CD(compact 

disk)developed for storage the data.and internet ,E-Mail & WWW(World Wide Web) developed.trying to 

developed artificial intelligence because computer can deside according to the condition  portable-

pc(personal computer-Laptop) & desktop-pc,took the movement in computer sector and it is used in every 

sector of Human life. 

Computer System is used For Only Binary System. 

Q. 4. Differentiate between Volatile & Non-Volatile memories. 

Answer:-   Volatile Memory: 

It is the memory hardware that fetches/stores data at a high-speed. It is also referred as temporary 

memory. The data within the volatile memory is stored till the system is capable of, but once the system 

is turned off the data within the volatile memory is deleted automatically. RAM (Random Access 

Memory) and Cache Memory are some common examples of volatile memory. Here, data fetch/store is 

fast and economical. 

Non-Volatile Memory: 
It is the type of memory in which data or information is not lost within the memory even power is shut-
down. ROM (Read Only Memory) is the most common example of non-volatile memory. It’s not 
economical and slow in fetch/store as compared to volatile memory however stores higher volume of 
data. All such information that needs to be stored for an extended amount of time is stored in non-
volatile memory. Non-volatile memory has a huge impact on a system’s storage capacity.  
Below are the differences between volatile and non-volatile memory:  

S.NO Volatile Memory Non-Volatile Memory 

1. 

Volatile memory is the type of 
memory in which data is lost as it 
is powered-off. 

Non-volatile memory is the type of 
memory in which data remains 
stored even if it is powered-off. 

2. 
Contents of Volatile memory is 
stored temporarily. 

Contents of Non-volatile memory 
is stored permanently. 

https://www.geeksforgeeks.org/different-types-ram-random-access-memory/
https://www.geeksforgeeks.org/different-types-ram-random-access-memory/
https://www.geeksforgeeks.org/cache-memory/
https://www.geeksforgeeks.org/computer-organization-ram-vs-rom/


                                                                        

S.NO Volatile Memory Non-Volatile Memory 

3. 
It is faster than non-volatile 
memory. It is slower than volatile memory. 

4. 
RAM(Random Access Memory) is 
an example of volatile memory. 

ROM(Read Only Memory) is an 
example of non-volatile memory. 

5. 

In volatile memory, data can be 
easily transferred in comparison 
to non-volatile memory. 

In non-volatile memory, data can 
not be easily transferred in 
comparison to volatile memory. 

6. 
In Volatile memory, process can 
read and write. 

In Non-volatile memory, process 
can only read. 

7. 
Volatile memory generally has 
less storage capacity. 

Non-volatile memory generally has 
more storage capacity than volatile 
memory. 

8. 

In volatile memory, the 
program’s data are stored which 
are currently in process by the 
CPU. 

In non-volatile memory, any kind 
of data which has to be saved 
permanently are stored. 

9. 
Volatile memory is more costly 
per unit size. 

Non-volatile memory is less costly 
per unit size. 

10. 

Volatile memory has a huge 
impact on the system’s 
performance. 

Non-volatile memory has a huge 
impact on a system’s storage 
capacity. 

11. 
In volatile memory, processor has 
direct access to data. 

In non-volatile memory, processor 
has no direct access to data. 

12. 

Volatile memory chips are 
generally kept on the memory 
slot. 

Non-volatile memory chips are 
embedded on the motherboard. 

 

Q.5. Distinguish among system softwere, application softwere and open source softwere on the basic of 

features. 

Answer:-   Software is of two types namely system software and application software. They both differ in 

terms of their purpose and design. System software is meant to administer the system resources. It also 



                                                                        

serves as a kind of platform for running the application software. On the other hand, application software 

is meant to enable the user to carry out some specific set of tasks or functions. 

Differences between System Software and 
Application Software 

System software is meant to manage the system 
resources. It serves as the platform to run 
application software. 

Application software helps perform a 
specific set of functions for which they 
have been designed. 

System software is developed in a low-level 
language (assembly language for example) 

Application software is developed in a 
high-level language such as Java, C++, 
.net and VB. 

System software automatically starts running 
once the system is turned on and stops when 
the system is shut down. 

Application software runs as and when 
the user requests it. 

A system cannot even start without system 
software 

Application software is user specific and it 
is not needed to run the system on the 
whole. 

System software is endowed with a general 
purpose. 

Application software carries a specific 
purpose. 

A typical example for a system software is 
Windows Operating System 

Some characteristic examples for 
application software is MS Office, 
Photoshop and CorelDraw 

System software provides an interface between the system hardware and the user. It lets the system 

understand the command that the user inputs. We can also say that the system software serves as an 

interface between the hardware in a system and application software. It is also called as general purpose 

software. The end user usually does not directly interact with the system software. The user only gets to 

interact with the GUI that has been created by the system software. 

What is Application Software? 

We can define an application software as software written on a high-level language such as Java, C++, .net and 

VB for instance. This software is meant to meet some specific needs of the user. Some of the kinds of 

application software are designing software, a computing software, and an editing software. There is a specific 

purpose behind every application software. 

Application software runs on the platform created by the system software. We can say that application 

software provides a kind of intermediary between the end user and the software installed on a computer. 

Application software is not absolutely essential for running a system, but it makes the system more useful. The 

MS Office you find on Windows-based systems is a typical example of application software. 

Examples and conclusion 

System software and application software together make a system useful to the end user. A system cannot 

run without system software. In other words, it is compulsory for making the system run. Application software 



                                                                        

is essential to perform specific tasks. They help achieve versatile kinds of functions on a system thus helping to 

customize a system for the specific requirements and situations of the user. 

Q. 6. (a) Create a file in MS-word to insert a paragraph about yourself and save it with file name “yourself”. 

Describe all steps involved in it. 

Answer :-   To change the font color :- 
1. Select the text you want to modify. 

2. On the Home tab, click the Font Color drop-downappears. 

3. Select the font color you want to use. The font color will change in the document 
4. Font style menu appears.  

5. With a left click select the desired font style . 

Q.6.  (b) Write steps regarding followings. 
    To change the font style  
     To change the font size  
     To change the font color 
     To highlight (in yellow )the line that reads need to get ims’s address  

Answer :-  

This page is related to changing font attributes in Microsoft Word. For fonts in HTML, see: How to change the 

font type, size, and color on a web page. 

In Microsoft Word, you can change the properties of any text, including font 
type, size, color, and make it bold, italic, or underlined (font style). The 
following illustration shows the formatting bar, and a description of the 
tools it contains. 

 

In Word 2003 or earlier, if you do not see the formatting bar when you open Word, click View, then Toolbars, 

and make sure Formatting has a check next to it. 

The font settings placement changed after Word 2003, with all the settings 

placed in the Font section on the Ribbon's Home tab. An example of the 

font settings in Word 2016 is pictured below. 

https://www.computerhope.com/issues/ch000072.htm
https://www.computerhope.com/issues/ch000072.htm
https://www.computerhope.com/jargon/m/microsoft-word.htm
https://www.computerhope.com/jargon/b/bold.htm
https://www.computerhope.com/jargon/i/italic.htm
https://www.computerhope.com/jargon/u/underlin.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


                                                                        

 

Select a link below to learn how to change font color, size, style, or type in 

Microsoft Word. 

• Changing font color. 
• Changing font size. 
• Changing font style. 
• Changing font type. 

Changing font color 

To change the font color in a Microsoft Word document, follow the 

steps below. 

1. Highlight the text you want to change. 
2. Click the down arrow next to the color icon on the formatting bar or Ribbon. It is usually 

displayed as the letter "A" with a red underline. 

 

3. After clicking the down arrow, select a color for the text. 
If you do not highlight any text, the font color changes at the cursor's location as soon as you start typing. 

Changing font size 

To change the font size in a Microsoft Word document, follow the 

steps below. 

1. Highlight the text you want to change. 
2. Click the down arrow next to the size box on the formatting bar or Ribbon to enlarge or 

reduce the font size. The default font size is usually 11 or 12. 

https://www.computerhope.com/issues/ch000829.htm#fontcolor
https://www.computerhope.com/issues/ch000829.htm#fontsize
https://www.computerhope.com/issues/ch000829.htm#fontstyle
https://www.computerhope.com/issues/ch000829.htm#fonttype
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm
https://www.computerhope.com/jargon/t/textcurs.htm
https://www.computerhope.com/jargon/h/highligh.htm
https://www.computerhope.com/jargon/f/formatting-toolbar.htm
https://www.computerhope.com/jargon/r/ribbon.htm


                                                                        

 

3. After clicking the down arrow for the size, you'll see a list of predesignated sizes to select. Some fonts 
do not scale properly, so they may have limited size options. 

Q.7. Create a file in MS-word for the following document  and save it with file name ‘ms_word’. Describe all 
steps involved in it.  
Answer  :-  Did you mean: create a file in ms -word for the following document and save it with file name ms-
word describe all steps involved in it . MS Word MS word is a widely used commercial word processor 
devlopment by microsoft MS word is aplication software which capable of creating editing saving and printing 
any type of document  

Showing results for create a file in ms "-word" for the following document and save it with file name ms-word 
describe all steps involved in it . MS Word MS word is a widley used commercial word processor devlopment 
by microsoft MS word is aplication software which capable of creatin editing saving and printing any type of 
document 
Search instead for create a file in ms -word for the following document and save it with file name ms-word 
describe all steps involved in it . MS Word MS word is a widley used commercial word processor devlopment 
by microsoft MS word is aplication software which capable of creatin editing saving and printing any type of 
document 

Q.8. Create a file in MS-word for the following document and save it with file name ‘equations’. Describe all 

steps involved in it. 

Answer :-  Creating a New Document 

When you start Word without opening an existing document, the program gives you an empty one to work in. 

If you’re eager to put words to page, then type away. Sooner or later, though, you’ll want to start another new 

document. Word gives you three ways to do so: 

 

Figure 1-1. When you start Word 2007 for the first time, it may look a little top-heavy. The ribbon takes up 

more real estate than the old menus and toolbars. This change may not matter if you have a nice big monitor. 

https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word+MS+word+is+a+widely+used+commercial+word+processor+devlopment+by+microsoft+MS+word+is+aplication+software+which+capable+of+creating+editing+saving+and+printing+any+type+of+document&spell=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQBSgAegQIAhAw
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word+MS+word+is+a+widely+used+commercial+word+processor+devlopment+by+microsoft+MS+word+is+aplication+software+which+capable+of+creating+editing+saving+and+printing+any+type+of+document&spell=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQBSgAegQIAhAw
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word+MS+word+is+a+widely+used+commercial+word+processor+devlopment+by+microsoft+MS+word+is+aplication+software+which+capable+of+creating+editing+saving+and+printing+any+type+of+document&spell=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQBSgAegQIAhAw
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word+MS+word+is+a+widely+used+commercial+word+processor+devlopment+by+microsoft+MS+word+is+aplication+software+which+capable+of+creating+editing+saving+and+printing+any+type+of+document&spell=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQBSgAegQIAhAw
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+%22-word%22+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQ2LwHegQIARAC
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+%22-word%22+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQ2LwHegQIARAC
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+%22-word%22+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQ2LwHegQIARAC
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+%22-word%22+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQ2LwHegQIARAC
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&nhr=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQh88HegQIARAD
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&nhr=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQh88HegQIARAD
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&nhr=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQh88HegQIARAD
https://www.google.com/search?sxsrf=ALeKk003xN8upQAsqIMAZSmChVMucgA7iw:1627670938926&q=create+a+file+in+ms+-word+for+the+following+document+and+save+it+with+file+name+ms-word+describe+all+steps+involved+in+it+.+MS+Word++++MS+word+is+a+widley+used+commercial+word+processor+devlopment+by+microsoft++MS+word+is+aplication+software+which+capable+of+creatin+editing+saving+and+++printing+any+type+of+document&nhr=1&sa=X&ved=2ahUKEwiCu4DhuovyAhUI73MBHfIwBZIQh88HegQIARAD


                                                                        

But if you want to reclaim some of that space, you can hide the ribbon by double-clicking the active tab. Later, 

when you need to see the ribbon commands, just click a tab. 

Creating a new blank document. When you’re preparing a simple document—like a two-page essay, a note 

for the babysitter, or a press release—a plain, unadorned page is fine. Or, when you’re just brainstorming and 

you’re not sure what you want the final document to look like, you probably want to start with a blank slate or 

use one of Word’s templates (more on that in a moment) to provide structure for your text. 

Creating a document from an existing document. For letters, resumes, and other documents that require 

more formatting, why reinvent the wheel? You can save time by using an existing document as a starting point 

(Section 1.2.2). When you have a letter format that you like, you can use it over and over by editing the 

contents. 

Creating a document from a template (Section 1.2.3). Use a template when you need a professional design 

for a complex document, like a newsletter, a contract, or meeting minutes. Templates are a lot like forms—the 

margins, formatting, and graphics are already in place. All you do is fill in your text. 

Microsoft provides a mind-boggling number of templates with Word, but they’re not the only source. You can 

find loads more on the Internet, as described in Secn 5.2.1. Your employer may even provide official templates 

for company documents. tio 

To start your document in any of the above ways, click the Windows logo in the upper-left corner of the 

screen. That’s Office 2007’s new Office button. Click it, and a drop-down menu opens, revealing commands for 

creating, opening, and saving documents. Next to these commands, you see a list of your Word documents. 

This list includes documents that are open, as well as those that you’ve recently opened. 

 

Figure 1-2. The phrase most frequently uttered by experienced Word fans the first time they start Word 2007 

is, “Okay, where’s my File menu?” Never fear, the equivalent of the File menu is still there—it’s just 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-2.2
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-SECT-2.3
https://www.oreilly.com/library/view/word-2007-the/059652739X/ch05.html#word2007tmm-CHP-5-SECT-2.1


                                                                        

camouflaged a bit. Clicking the Office button (the one that looks like a Windows logo) reveals the commands 

you use to create, open, and save Word documents. 

Creating a New Blank Document 

Say you want a new blank document, just like the one Word shows you when you start the program. No 

problem—here are the steps:- 

1. Choose Office button → New. 

The New Document dialog box appears. 

2. In the upper-left corner of the large “Create a new Word document” panel, click “Blank The New 

Document box presents a seemingly endless number of options, but don’t panic. The “Blank document” 

option you want is on the left side of the first line. 

3. At the bottom of the New Document dialog box, click Create. 

The dialog box disappears, and you’re gazing at the blank page of a new Word document. 

Better get to work. 

document” (Figure 1-3). 

 

Figure 1-3. Open the New Document box (Office button → New, or Alt+F, N), and Word gives you several ways 

to create a new document. Click “Blank document” to open an empty document, similar to the one Word 

shows when you first start the program. Or you can click “New from existing” to open a document that you 

previously created under a new name. 

Q.9. Create a file in MS-word that convert existing highlight text to table as shown below and save it as file 

name ‘text_to_table’. Describe all steps involved in it. 

Answer :-  To convert text to a table or a table to text, start by clicking the Show/Hide paragraph mark on 
the Home tab so you can see how text is separated in your document. 

 

https://www.oreilly.com/library/view/word-2007-the/059652739X/ch01.html#word2007tmm-CHP-1-FIG-3


                                                                        

1. Insert separator characters—such as commas or tabs—to indicate where to divide the text into table columns. 
Note: If you have commas in your text, use tabs for your separator characters. 

2. Use paragraph marks to indicate where you want to begin a new table row. 
In this example, the tabs and paragraph marks will produce a table with 3 columns and 2 rows: 

 
3. Select the text that you want to convert, and then click Insert > Table > Convert Text to Table. 

 
4. In the Convert Text to Table box, choose the options you want. 

 
Under Table size, make sure the numbers match the numbers of columns and rows you want. 
Under AutoFit behavior, choose how you want your table to look. Word automatically chooses a width for the 
table columns. If you want a different column width, choose one of these options: 

To do this Choose this option 

Specify a width for all the columns In the Fixed column 
width box, type or select a 
value. 

Resize the columns to fit the width of the text in each column AutoFit to contents 



                                                                        

Resize the table automatically in case the width of the available 
space changes (for example, web layout or landscape orientation) 

AutoFit to window 

Under Separate text at, choose the separator character you used in the text. 
5. Click OK. The text converted to a table should look something like this: 

 
1. Select the rows or table you want to convert to text. 
2. On the Layout tab, in the Data section, click Convert to Text. 

 
3. In the Convert to Text box, under Separate text with, click the separator character you want to use in place of 

the column boundaries. Rows will be separated by paragraph marks. 
4. Click OK. 

Q.10. Create a file in MS-Word to insert a table in the document. Describe all steps involved in it.  

Answer :-  
1. Open a blank Word document. 
2. In the top ribbon, press Insert. 
3. Click on the Table button. 
4. Either use the diagram to select the number of columns and rows you need, or click Insert Table and a dialog 

box will appear where you can specify the number of columns and rows. 
5. The blank table will now appear on the page. 

Q.11. Create a following worksheet in MS-excel and save it with name ‘book1’. 

Answer :-  Introduction 
By the end of this lesson, you should be able to: 

• Create a workbook 
• Save a workbook 
• Open a workbook 
• Close a workbook 

Understanding file terms 

The File menu contains all of the operations we'll discuss in this lesson: New, Open, Close, Save, and Save As. 

 



                                                                        

New 

This is used to create a new workbook. 
Open 

This is used to open an existing file from a floppy disk or hard drive of your computer. 
Close 

This is used to close a spreadsheet. 
Save As 

This is used when you're saving a new file for the first time or saving an existing file with a different name. 
Save 

This is used to save a file that has had changes made to it. If you close the workbook without saving, any 

changes made will be lost. 

To learn more, check out the different parts of the Excel window. 
Creating a workbook 

A blank workbook is displayed when Microsoft Excel XP is first opened. You can type information or design a 

layout directly in this blank workbook. 
To create an Excel XP workbook: 

• Choose File New from the menu bar. 
 

 
• The New Workbook task pane opens on the right side of the screen. 

 

 
• Choose Blank Workbook under the New category heading. 
• A blank workbook opens in the Excel window. The New Workbook task pane is closed. 

Saving a workbook 

Every workbook created in Excel must be saved and assigned a name to distinguish it from other workbooks. 

The first time you save a workbook, Excel will prompt you to assign a name through the Save As operation. 

https://edu.gcfglobal.org/en/excel/getting-started-with-excel/1/#parts-of-excel-window


                                                                        

Once the file is assigned a name, any additional changes made to the text, numbers, or formulas must be 

saved using the Save operation. 
To save a new workbook: 

• Choose File Save As from the menu bar. 

 
• The Save As dialog box appears. 
• Click the Save In: drop-down menu and locate where the file will be saved. Choose 3 1/2 Floppy 

(A:) to save the file to a floppy disk or Local Disk (C:) to save the file to your computer. 
• Type a name for your file in the File Name: box. 
• Click the Save button. 

 
To save changes made to an existing workbook: 

• Choose File Save from the menu bar. 
OR 

• Click the Save button on the Standard toolbar. 

If you're saving the file for the first time and do not choose a file name, Microsoft Excel will assign a file 

name for you. 

It is a good idea to save frequently when working in a spreadsheet. Losing information is never fun! You 

can quickly save your spreadsheet by using the quick-key combination Ctrl+S. 
Opening a workbook 

You can open any workbook that has previously been saved and given a name. 
To open an existing Excel XP workbook: 

• Choose File Open from the menu bar. 

 



                                                                        

• The Open dialog box opens. 

 
• In the Look in list, click the drive, folder, or Internet location that has the file you want to open. 
• In the folder list, open the folder that contains the file. Once the file is displayed, click the file 

you want to open. 
• Click the Open button. 

Closing a workbook 
To close an existing Excel XP workbook: 

• Choose File Close from the menu bar. The workbook in the Excel window is closed. 

 
Excel XP will prompt you to save information if anything has been typed between the last save and the 

time you close the file. 
Challenge! 

• Create a new blank file and save as to c:\my documents as "test.xls". 
• Close the file. 
• Open the file. 
• Save the file after making at least one change to it. 

Q.12. Calculate the following things of a range (C2:C11) of data in the worksheet created in question no 10.  

Answer :-  Formulas 

Formulas in Excel are basically mathematical expressions that use cell references (e.g., “A5”,” D17”) as 
arguments.  For example, a formula that adds the contents of cell E5 and E6 could be written as follows: 

    = E5+E6 
(Note: all formulas in Excel need to be preceded by an “=” sign.) If the values contained in E5 and E6 are 6 and 
11, respectively, the formula will produce 17 as the value it displays. If you change E5 to 7, the result will 
automatically change to 18. 
Example 
Let's say you were putting together an office supply order, and you wanted to keep track of much you were 
spending. You could put together a spreadsheet like the one below, with the list of items to be purchased, 



                                                                        

their unit prices, the number of each item ordered, and the total spent for each.  It would make sense to enter 
the things you know in advance (like the price of individual items and the number ordered), but you could let 
Excel calculate the totals for you.  For the first item listed below (pencils), this could be done by making the 
value of the total price (cell D2), the value of the unit price (held in cell C2) multiplied by the number of items 
ordered (held in D2).  This formula would be written "=B2*C2". 

 

After hitting "Enter", the cell will display the calculated value, while the formula bar will still display the 
formula.  (Note: Always hit “Enter” when finished entering a formula, manually.  If you click off the cell, the 
cell you click to will be added to your formula.) 

 

Excel will generally be able to handle any properly-input mathematical formula, if valid operators are used. 
Commonly used operators include "+" (addition), "-" (subtraction), "*" (multiplication) and "/" 
(division).  (Microsoft has a complete list of valid operators to be used in Excel formulas on the Office 
website).  Here are some examples of formulas using common operators: 
Formula                                                                              Description 
=C2-B2                                                                Subtracts contents of B2 from contents of C2 
=C2/B2                                                                Divides contents of C2 by contents of B2 
=(B2+C2+D2)/3                                                  Adds contents of B2, C2, and D2 and divides result by 3 

Excel also has built-in functions that can do a lot of useful calculations.  These are most easily accessed by 
hitting the Insert Function button, which is represented by the “fx” symbol next to the formula bar.  For 
example, instead of entering the formula shown above, the same result could have been achieved using the 
built-in "PRODUCT" function by clicking in cell D2 and hitting the Insert Formula button.  This would give a 
dialog box like the one shown, below. 

https://support.office.com/en-us/article/Calculation-operators-and-precedence-in-Excel-48be406d-4975-4d31-b2b8-7af9e0e2878a


                                                                        

 

After selecting "PRODUCT" and clicking OK, you will get another dialog box, that allows you to select the cells 
to be multiplied.  You can do this for individual cells, by selecting cells separately in the "Number1" 
and  "Number2" boxes shown below, or by selecting an array of cells, by clicking and dragging on the range 
cells you want to use on the spreadsheet, itself.  (Note: if you try to enter a formula in a cell using the Insert 
Formula button and there are adjacent cells with numbers, Excel will often select those cells automatically, so 
make sure the cells selected in the dialog box are the correct ones.)  

 

Once you click "OK", your completed formula will be input into the cell. 
Copying and pasting formulas 
Often, you will need Excel to do a series of similar computations, where the only things that will change are 
the cells used as arguments.  For instance, in the example above, you would probably like Excel to calculate 
the Total Price for each item in the order.  You could re-input the same formula used to get the total price for 
pencils in each cell in that row, just changing the cells referenced (i.e. "=PRODUCT(B3:C3)", 
"=PRODUCT(B4:C4)", etc.), but Excel has simpler method for this. If you have multiple cells in the same row or 
column that need to do the same computation, you can simply copy the value in the cell you entered a 
formula, and then paste it into the subsequent cells.  Excel will then automatically adjust which cells are 
included in the formula, based upon which cell the formula was pasted to.  So, if the original formula entered 
in D2 was "=PRODUCT(B2:C2)", the formula pasted into D4 would be "=PRODUCT(B4:C4)" 
More simply, if you have a formula you want repeated in a number of directly adjoining cells, you can just click 
and drag the bottom right corner of the cell with the original formula (see image below) onto the cells you 



                                                                        

want the same formula entered, and Excel will automatically copy and paste the formula for you, with 
appropriate adjustments made to the cell numbers in the formula. 

 

the sum of the marks using AutoSum in a range of cells (C2:C11) 

You can use a simple formula to sum numbers in a range (a group of cells), but the SUM function is easier to 
use when you’re working with more than a few numbers. For example =SUM(A2:A6) is less likely to have 
typing errors than =A2+A3+A4+A5+A6. 

 
Here’s a formula that uses two cell ranges: =SUM(A2:A4,C2:C3) sums the numbers in ranges A2:A4 and C2:C3. 
You’d press Enter to get the total of 39787. 
To create the formula: 

1. Type =SUM in a cell, followed by an opening parenthesis (. 
2. To enter the first formula range, which is called an argument (a piece of data the formula needs to run), 

type A2:A4 (or select cell A2 and drag through cell A6). 
3. Type a comma (,) to separate the first argument from the next. 
4. Type the second argument, C2:C3 (or drag to select the cells). 
5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single cell references, all separated by commas. 
▪ =SUM(A2:A4,2429,10482) 
▪ =SUM(4823,A3:A4,C2:C3) 
▪ =SUM(4823,12335,9718,C2:C3) 
▪ =SUM(A2,A3,A4,2429,10482) 

 average of the marks in a range of cells (C2:C11) 

Formula 

=AVERAGE(number1, [number2], …) 

The function uses the following arguments: 
1. Number1 (required argument) – This is the first number of a cell reference or a range for which we 

want the average. 
2. Number2 (optional argument) – They are the additional numbers, cell references or a range for which 

we want the average. A maximum of 255 numbers is allowed. 
How to use AVERAGE Function in Excel?       

To understand the uses of the AVERAGE function, let us consider a few examples: 

https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89


                                                                        

Example 1 – Average in Excel 

Suppose we are given the following data: 

 

We wish to find out the top 3 scores in the above data set. The formula to use will be: 

  

 
We get the result below: 

 
In the above formula, the LARGE function retrieved the top nth values from a set of values. So, we got the top 
3 values as we used the array constant {1,2,3} into LARGE for the second argument. 
Later, the AVERAGE function returned the average of the values. As the function can automatically handle 
array results, we don’t need not use Ctrl+Shift+Enter to enter the formula. 
Example 2 – Average in Excel 

Suppose we are given the data below: 

  



                                                                        

 
The formula to use is shown below: 

 
We get the following result: 

 
A few notes about the AVERAGE Function 

1. The AVERAGE function ignores empty cells. 
2. If a range or cell reference argument contains text, logical values, or empty cells, those values are 

ignored. However, cells with the value zero are included. 
3. Arguments that are error values or text that cannot be translated into numbers cause errors in the 

function. 

highest marks in a range of cells (C2:C11) 

You can use a simple formula to sum numbers in a range (a group of cells), but the SUM function is easier to 
use when you’re working with more than a few numbers. For example =SUM(A2:A6) is less likely to have 
typing errors than =A2+A3+A4+A5+A6. 

 
Here’s a formula that uses two cell ranges: =SUM(A2:A4,C2:C3) sums the numbers in ranges A2:A4 and C2:C3. 
You’d press Enter to get the total of 39787. 
To create the formula: 

https://support.microsoft.com/en-us/office/use-excel-as-your-calculator-a1abc057-ed11-443a-a635-68216555ad0a
https://support.microsoft.com/en-us/office/sum-function-043e1c7d-7726-4e80-8f32-07b23e057f89


                                                                        

1. Type =SUM in a cell, followed by an opening parenthesis (. 
2. To enter the first formula range, which is called an argument (a piece of data the formula needs to run), 

type A2:A4 (or select cell A2 and drag through cell A6). 
3. Type a comma (,) to separate the first argument from the next. 
4. Type the second argument, C2:C3 (or drag to select the cells). 
5. Type a closing parenthesis ), and then press Enter. 

Each argument can be a range, a number, or single cell references, all separated by commas. 
▪ =SUM(A2:A4,2429,10482) 
▪ =SUM(4823,A3:A4,C2:C3) 
▪ =SUM(4823,12335,9718,C2:C3) 
▪ =SUM(A2,A3,A4,2429,10482) 

minimum marks in a range of cells (C2:C11) 

Formulas 

Formulas in Excel are basically mathematical expressions that use cell references (e.g., “A5”,” D17”) as 
arguments.  For example, a formula that adds the contents of cell E5 and E6 could be written as follows: 

= E5+E6  
(Note: all formulas in Excel need to be preceded by an “=” sign.) If the values contained in E5 and E6 are 6 and 
11, respectively, the formula will produce 17 as the value it displays. If you change E5 to 7, the result will 
automatically change to 18. 
Example 
Let's say you were putting together an office supply order, and you wanted to keep track of much you were 
spending. You could put together a spreadsheet like the one below, with the list of items to be purchased, 
their unit prices, the number of each item ordered, and the total spent for each.  It would make sense to enter 
the things you know in advance (like the price of individual items and the number ordered), but you could let 
Excel calculate the totals for you.  For the first item listed below (pencils), this could be done by making the 
value of the total price (cell D2), the value of the unit price (held in cell C2) multiplied by the number of items 
ordered (held in D2).  This formula would be written "=B2*C2". 

 
After hitting "Enter", the cell will display the calculated value, while the formula bar will still display the 
formula.  (Note: Always hit “Enter” when finished entering a formula, manually.  If you click off the cell, the 
cell you click to will be added to your formula.) 

 



                                                                        

Excel will generally be able to handle any properly-input mathematical formula, if valid operators are used. 
Commonly used operators include "+" (addition), "-" (subtraction), "*" (multiplication) and "/" 
(division).  (Microsoft has a complete list of valid operators to be used in Excel formulas on the Office 
website).  Here are some examples of formulas using common operators: 
Formula                                                                              Description 
=C2-B2                                                                Subtracts contents of B2 from contents of C2 
=C2/B2                                                                Divides contents of C2 by contents of B2 
=(B2+C2+D2)/3                                                  Adds contents of B2, C2, and D2 and divides result by 3 
Excel also has built-in functions that can do a lot of useful calculations.  These are most easily accessed by 
hitting the Insert Function button, which is represented by the “fx” symbol next to the formula bar.  For 
example, instead of entering the formula shown above, the same result could have been achieved using the 
built-in "PRODUCT" function by clicking in cell D2 and hitting the Insert Formula button.  This would give a 
dialog box like the one shown, below. 

 
After selecting "PRODUCT" and clicking OK, you will get another dialog box, that allows you to select the cells 
to be multiplied.  You can do this for individual cells, by selecting cells separately in the "Number1" 
and  "Number2" boxes shown below, or by selecting an array of cells, by clicking and dragging on the range 
cells you want to use on the spreadsheet, itself.  (Note: if you try to enter a formula in a cell using the Insert 
Formula button and there are adjacent cells with numbers, Excel will often select those cells automatically, so 
make sure the cells selected in the dialog box are the correct ones.)  

 
Once you click "OK", your completed formula will be input into the cell. 
Copying and pasting formulas 

https://support.office.com/en-us/article/Calculation-operators-and-precedence-in-Excel-48be406d-4975-4d31-b2b8-7af9e0e2878a


                                                                        

Often, you will need Excel to do a series of similar computations, where the only things that will change are 
the cells used as arguments.  For instance, in the example above, you would probably like Excel to calculate 
the Total Price for each item in the order.  You could re-input the same formula used to get the total price for 
pencils in each cell in that row, just changing the cells referenced (i.e. "=PRODUCT(B3:C3)", 
"=PRODUCT(B4:C4)", etc.), but Excel has simpler method for this. If you have multiple cells in the same row or 
column that need to do the same computation, you can simply copy the value in the cell you entered a 
formula, and then paste it into the subsequent cells.  Excel will then automatically adjust which cells are 
included in the formula, based upon which cell the formula was pasted to.  So, if the original formula entered 
in D2 was "=PRODUCT(B2:C2)", the formula pasted into D4 would be "=PRODUCT(B4:C4)" 
More simply, if you have a formula you want repeated in a number of directly adjoining cells, you can just click 
and drag the bottom right corner of the cell with the original formula (see image below) onto the cells you 
want the same formula entered, and Excel will automatically copy and paste the formula for you, with 
appropriate adjustments made to the cell numbers in the formula. 

 

Q.13. (a) Describe various steps involved in the following  

Answer :-  



                                                                        

Steps involved in process of planning: 

1. Goal setting: Plans are the means to achieve certain ends or objectives. Therefore, establishment of organizational 

or overall objectives is the first step in planning. Setting objectives is the most crucial part of planning. The 

organizational objectives should be set in key areas of operations. 

2. Developing the planning premises: Before plans are prepared, the assumptions and conditions underlying them 

must be clearly defined these assumptions are called planning premises and they can be identified through accurate 

forecasting of likely future events. 

3. Reviewing Limitations: In practice, several constraints or limitations affect the ability of an organization to achieve 

its objectives. These limitations restrict the smooth operation of plans and they must be anticipated and provided 

for. 

4. Deciding the planning period: Once the broad goals, planning premises and limitations are laid down, the next 

step is to decide the period of planning. The planning period should be long enough to permit the fulfillment of the 

commitments involved in a decision. 

5. Formulation of policies and strategies: After the goals are defined and planning premises are identified, 

management can formulate policies and strategies for the accomplishment of desired results. The responsibility for 

laying down policies and strategies lies usually with management. But, the subordinates should be consulted as they 

are to implement the policies and strategies. 

6. Preparing operating plans: After the formulation of overall operating plans, the derivative or supporting plans are 

prepared. Several medium range and short-range plans are required to implement policies and strategies. 

7.Integration of plans: Different plans must be properly balanced so that they support one another. Review and 

revision may be necessary before the plan is put into operation. Moreover, the various plans must be 

communicated and explained to those responsible for putting them into practice. 

 To modify column width of a worksheet 

Set a column to a specific width 
1. Select the column or columns that you want to change. 
2. On the Home tab, in the Cells group, click Format. 
3. Under Cell Size, click Column Width. 
4. In the Column width box, type the value that you want. 
5. Click OK. 

To modify the row height of a worksheet 

1. Select the row or rows that you want to change. 
2. On the Home tab, in the Cells group, click Format. 
3. Under Cell Size, click Row Height. 
4. In the Row height box, type the value that you want, and then click OK. 

To delete rows and columns of a worksheet 

Delete cells, rows, or columns 
1. Select the cells, rows, or columns that you want to delete. 
2. Right-click, and then select the appropriate delete option, for example, Delete Cells & Shift Up, Delete Cells & 

Shift Left, Delete Rows, or Delete Columns. 

Q.13. (b) Describe following terms in the worksheet 



                                                                        

Answer :-  

Microsoft Excel terminology 

Workbook — The workbook refers to an Excel spreadsheet file. The workbook houses all of the data that you 

have entered and allows you to sort or calculate the results. A workbook that is available to be viewed and 

edited by multiple users on a network is known as a Shared Workbook. 

Worksheet — Within the workbook is where you'll find documents called worksheets. Also known as 

spreadsheets, you can have multiple worksheets nestled in a workbook. Tabs at the bottom of the of the 

screen will indicate which of your worksheets you are currently working on. This is also known as an active 

worksheet or active sheet. 

Cell — A cell is a rectangle or block housed in a worksheet. Any data that you want to enter into your 

worksheet must be placed in a cell. Cells can be color coded, display text, numbers and the results of 

calculations, based on what you want to accomplish. An Active Cell is one that is currently opened for editing. 

Absolute reference and relative reference in formula 

A worksheet in Excel is made up of cells. These cells can be referenced by specifying the row value and the 
column value. 
For example, A1 would refer to the first row (specified as 1) and the first column (specified as A). Similarly, B3 
would be the third row and second column. 
The power of Excel lies in the fact that you can use these cell references in other cells when creating formulas. 
Now there are three kinds of cell references that you can use in Excel: 

• Relative Cell References 
• Absolute Cell References 
• Mixed Cell References 

Understanding these different types of cell references will help you work with formulas and save time 
(especially when copy-pasting formulas). 

This Tutorial Covers: 

• What are Relative Cell References in Excel? 

o When to Use Relative Cell References in Excel? 

• What are Absolute Cell References in Excel? 

o What does the Dollar ($) sign do? 

o When to Use Absolute Cell References in Excel? 

• What are Mixed Cell References in Excel? 

• How to Change the Reference from Relative to Absolute (or Mixed)? 
Let me take a simple example to explain the concept of relative cell references in Excel. 
Suppose I have a data set shown below: 

https://trumpexcel.com/absolute-relative-mixed-cell-references/#What-are-Relative-Cell-References-in-Excel
https://trumpexcel.com/absolute-relative-mixed-cell-references/#When-to-Use-Relative-Cell-References-in-Excel
https://trumpexcel.com/absolute-relative-mixed-cell-references/#What-are-Absolute-Cell-References-in-Excel
https://trumpexcel.com/absolute-relative-mixed-cell-references/#What-does-the-Dollar-sign-do
https://trumpexcel.com/absolute-relative-mixed-cell-references/#When-to-Use-Absolute-Cell-References-in-Excel
https://trumpexcel.com/absolute-relative-mixed-cell-references/#What-are-Mixed-Cell-References-in-Excel
https://trumpexcel.com/absolute-relative-mixed-cell-references/#How-to-Change-the-Reference-from-Relative-to-Absolute-or-Mixed


                                                                        

 
To calculate the total for each item, we need to multiply the price of each item with the quantity of that item. 
For the first item, the formula in cell D2 would be B2* C2 (as shown below): 

 

Cell address 

The cell ADDRESS function is categorized under Lookup and Reference functions. It will provide a cell 

reference (it’s “address”) by taking the row number and column letter. The cell reference will be provided as a 

string of text. The function can return an address in a relative or absolute format and can be used to construct 

a cell reference inside a formula. 

As a financial analyst, cell ADDRESS can be used to convert a column number to a letter, and vice versa. We 

can use the function to address the first cell or last cell in a range. 

Q.14. (a) What tools are available to customize our PowerPoint presentation?  

Answer :- 
1.  Click the Slide Show tab. 
2. Click the Custom Slide Show button. 
3. Select Custom Shows. 
4. Click the New button. 
5. Type a new name for the slide show. 
6. Select the slides you want to be part of the presentation. 
7. Click the Add button. 
8. Click OK. 

Q.14  (b) Write the steps for the following action for creation of power point presentation 

Answer :-  

1. Step 1: Launch the PowerPoint Program. ... 
2. Step 2: Choosing a Design. ... 
3. Step 3: Create Title Page. ... 
4. Step 4: Add More Slides. ... 
5. Step 5: Add Charts, Pictures, Graphs, Etc. ... 
6. Step 6: Add Transitions. ... 
7. Step 7: Changing the Order. ... 



                                                                        

8. Step 8: Play the Presentation. 

Open a Blank presentation  

When beginning a new project in PowerPoint, you'll often want to start with a new blank presentation. 
1. Select the File tab to go to Backstage view. 
2. Select New on the left side of the window, then click Blank Presentation. 
3. A new presentation will appear. 

Save the presentation as Lab1.pptx 

The following are the basic steps to save a presentation. 
1. Step 1 − Click on the File tab to launch the Backstage view and select Save. 
2. Step 2 − In the Save As dialog, type in the file name and click "Save". 
3. Step 3 − The default file format is . pptx. 

Add a Title to the first slide: the name of your college 

Use the Layout option to title a slide 
Select the slide whose layout you will change so that it can have a title. Click Home > Layout. Select Title Slide 
for a standalone title page or select Title and Content for a slide that contains a title and a full slide text box. ... 
Select the Click to add title text box. 
Set as Slide Title: No Title placeholder exists on ... 
Add Slide Title: PowerPoint adds a Title place... 

 Type your first name and last name in the Subtitle section 

1. Open a Blank presentation 
2. Save the presentation as PowerPointLabOne.pptx 
3. Add a Title to the first slide: the name of your college 
4. Type your first name and last name in the Subtitle section 
5. Add a New Slide which has a Title and Content 
6. Add a title to the second slide “My Future Goals” 
7. In the Content section of the second slide, add at least three Personal Goals 
8. Right click on the second slide from the left panel, then choose Duplicate Slide 
9. Highlight the text in the Content area of the third slide. Under the Home tab, click Convert to SmartArt, 

then choose Basic Cycle 
10. Change the SmartArt Colors to Colorful—Accent Colors 
11. Change the SmartArt Styles to 3D Polished 
12. From the left panel, drag the third slide between the first and second slide 
13. Change the layout of the third slide, the slide that does not have the SmartArt, to Comparison 
14. Leave the title “My Future Goals” 
15. In the head of the first column, type “Goals in College,” then center the heading 
16. In the head of the second column, type “Goals after College,” then center the heading 
17. Add at least three goals in each section 
18. Make sure that slide #3 is selected from the left panel, then add a New Slide 
19. Change the layout of the new slide to Blank 
20. Insert a Graduation Online Picture from the Office ClipArt—Choose any image of your choice 
21. Change the ClipArt size to 3” X 3” and position it in the middle of the slide 
22. Apply the Wisp Design Theme 
23. Save and upload PowerPointLabOne.pptx to your instructor 



                                                                        

Add a New Slide which has a Title and Content 

Add a new slide 
1. In the slide thumbnail pane on the left, click the slide that you want your new slide to follow. 
2. On the Home tab, click New Slide. 
3. In the New Slide dialog box, select the layout that you want for your new slide. Learn more about slide layouts. 
4. Select Add Slide. 

Q.15. Write steps for creation of a set of PowerPoint slides that demonstrates your skill to use the tools of 

PowerPoint. It should include the following things 

Answer :-  

1. Step 1: Launch the PowerPoint Program. ... 
2. Step 2: Choosing a Design. ... 
3. Step 3: Create Title Page. ... 
4. Step 4: Add More Slides. ... 
5. Step 5: Add Charts, Pictures, Graphs, Etc. ... 
6. Step 6: Add Transitions. ... 
7. Step 7: Changing the Order. ... 
8. Step 8: Play the Presentation. 

 Title slide&bullet list 

Creating a simple bulleted list slide 
• Start Microsoft PowerPoint. 
• Open arbitrary existing PowerPoint presentation. 
• Click the New Slide button on the Formatting toolbar. ... 
• Click the Bulleted List layout, as shown in the above figure. ... 
• Click the title placeholder (where it says: “Click to Add Title”). ... 
• Type some text. 

  Inserting Excel Sheet 

How do you add a new worksheet to the right? 
To insert a single new worksheet to the right of the currently selected worksheet, click the “New Sheet” 
button at the right end of the spreadsheet name tabs. Alternatively, you can also click the “Insert” drop-down 
button in the “Cells” button group on the “Home” tab of the Ribbon 

Clip art and Text 

How do you make text art? 

1. Step 1: Choose a Picture. Choose any image from the internet or from your desktop. 
2. Step 2: Copy the Picture Into Word. Open a new Word-document and paste the picture into it. 
3. Step 3: Set the Image Properties. 
4. Step 4: Set the Font and Begin to 'paint' 
5. Step 5: Finish. 

Slide show effects 

 animations and effects 
1. Select the object or text you want to animate. 
2. Select Animations and choose an animation. 
3. Select Effect Options and choose an effect 



                                                                        

Q.16. What is the difference between Machine Language and High Level Language?  

Answer:-  Machine language, or machine code, is the only language that is directly understood by the 

computer, and it does not need to be translated. All instructions use binary notation and are written as a 

string of 1s and 0s. A program instruction in machine language may look something like this: 

1. 10010101100101001111101010011011100101  
 
A high-level language is a programming language that uses English and mathematical symbols, like +, -, % and 
many others, in its instructions. When using the term 'programming languages,' most people are actually 
referring to high-level languages. High-level languages are the languages most often used by programmers to 
write programs. Examples of high-level languages are C++, Fortran, Java and Python. 
To get a flavor of what a high-level language actually looks like, consider an ATM machine where someone 
wants to make a withdrawal of $100. This amount needs to be compared to the account balance to make sure 
there are enough funds. The instruction in a high-level computer language would look something like this: 

1. x = 100  
2. if balance x:  
3.  print 'Insufficient balance'  
4. else:  
5.  print 'Please take your money'  

This is not exactly how real people communicate, but it is much easier to follow than a series of 1s and 0s in 
binary code. 
There are a number of advantages to high-level languages. 
The first advantage is that high-level languages are much closer to the logic of a human language. 
The second advantage is that the code of most high-level languages is portable and the same code can run on 
different hardware 

Q.17. Discuss about different data types of C programming Language. 

Answer:-  

Data types in C programming language 
One of the most important concept in programming is the variable. The variable can be seen as the “place” to 
store “things” as: numerical values, characters, text strings, memory addresses, etc. There are two main 
concepts regarding variables. The fist concept is the declaration of the variable, which basically means setting 
its data type. The second concept is the definition of the variable, which means setting its content. 
In the C programming language every variable used in the source code needs to be declared by setting its data 
type. By assigning a certain data type to a variable we define several aspects linked to the variable: 
▪ the memory size to be allocated to store the content of the variable 
▪ the types of operations that can be performed on the variable 
▪ the restrictions which are applied in terms of operations 

By the end of this tutorial the reader will know: 

▪ what is the significance of a data type 
▪ how to declare and define a variable 
▪ which are the properties of the standard data types 
▪ what is integer overflow 

In the C programming language a variable is declared as: 
where: 

uivar – is the name of the variable 
unsigned – keyword which defines that our variable is always positive (without the sign “-“) 

http://x-engineer.org/graduate-engineering/programming-languages/c/introduction-to-c-programming/
http://x-engineer.org/graduate-engineering/programming-languages/c/how-c-programming-works-from-editor-to-executable/


                                                                        

int – keyword which defines that our variable is an integer and has 4 bytes of memory allocated (for a 32-bit 
compiler) 
The definition of the variable can be done in another line, but only after the declaration: 
Variables can be declared and defined in the same instruction: 
The main data types in C programming language are: 
▪ integer (fixed-point) 
▪ floating-point 
▪ void 

 

Q.18. Find the output of the following expressions 

Answer :- sorted () functions sorts the element of the list and returns the resulting sorted  list but it does not 

modify the original list so output is  

(a) X=20/5*2+30-5                     (b) Y=30 – (40/10+6) +10                     (c) Z= 40*2/10-2+10  

     X =
20

5
 . 2 +30 -5                             Y=    30-(

40

10
 +6) +10                               Z=  

40.2

10
 -2+10 

          Solve                                               Solve                                                 Solve 

Divide the numbers                        Divide the numbers                           Divide the numbers                                                                                                                                                                                                                           

    X = 
20

5
 .2+30 -5                               Y= 30-(

40

10
+ 6) + 10                             Z =

40.2

10
 -2+10 

    X = 4 . 2 +30 -5                               Y= 30-(10)+10                                       Z = 
80

10
 -2+10                                                                                                                                                            

 Multiply the numbers                    Add the numbers                              Add the numbers                                                                      

    X=4.2+30-5                                     Y= 30-(4+6)+10                                    Z= 
80

10
 -2+10 

    X=8 +30-5                                       Y = 30 –(10)+10                                    Z = 8-2+10                                                                                                                                                                                                                                                                                             

Add the numbers                               Y= 30-1 Û10 +10                                   Z= 8-2+10 

    X =8+30-5                                        Y= 30-10 +10                                     solution 

    X=33                                               Add the number                                    Z= 16          

Solution                                               Y = 30-10+10                                       

     X= 33                                               Y= 30                                                      

                                                            Solution                                                                                

                                                              Y = 30 

http://x-engineer.org/graduate-engineering/programming-languages/c/the-anatomy-of-a-c-code-source-file/
http://x-engineer.org/wp-content/uploads/2017/04/C-programming-language-standard-data-types.jpg?8a0af4&8a0af4


                                                                        

Q.19. Describe the syntax of the following statements 

Answer :- 

There are five types of SQL commands: DDL, DML, DCL, TCL, and DQL. 
• Data Definition Language (DDL) DDL changes the structure of the table like creating a table, deleting a table, 

altering a table, etc. ... 
• Data Manipulation Language. ... 
• Data Control Language. ... 
• Transaction Control Language. ... 
• Data Query Language. 

( a) If – else statement      

An if else Python statement evaluates whether an expression is true or false. If a condition is true, the “if” 

statement executes. Otherwise, the “else” statement executes. Python if else statements help coders control 

the flow of their programs.      

 (b) for loop    

What are the 3 types of loops? 
Loops are control structures used to repeat a given section of code a certain number of times or until a 
particular condition is met. Visual Basic has three main types of loops: for.. next loops, do loops and while 
loops. 

 (c) while loop   

What is a while loop ? 
Overview. The while construct consists of a block of code and a condition/expression. ... This repeats until the 
condition/expression becomes false. Because the while loop checks the condition/expression before the block 
is executed, the control structure is often also known as a pre-test loop.    

  (d) do-while loop  

What is a do while loop ? 
Do While Loop Flow Chart 
Execute/Run a group of statements within the C Programming loop. Next, use Increment and Decrement 
Operator inside the loop to increment or decrements the values. Next, it checks the while condition. If the 
condition output is True, the code inside the C Do while loop executes again 

Q.20. Find the output of the following program segments  

Answer :-  

    (a) Find the output of the following program. 

def fun(s): 
    n = len(s) 
    m='' 
    for i in range(0, n): 
        if (s[i] >= 'a' and s[i] <= 'm'):  
            m = m +  s[i].upper() 
        elif (s[i] >= 'n' and s[i] <= 'z'): 
            m = m +  s[i-1] 
        elif (s[i].isupper()): 
            m = m +  s[i].lower() 



                                                                        

        else:  
            m = m +  '#' 
    print(m) 
fun('Gini%Jony')  
  gIiI#jJon 

       (b)  Find the output of the following program. 
def Withdef(HisNum = 30): 
    for i in range(20,HisNum+1,5): 
        print(i, end=" ") 
    print() 
def Control(MyNum): 
    MyNum = MyNum + 10 
    Withdef(MyNum) 
YourNum = 25; 
Control(YourNum); 
Withdef(); 
print("Number = " ,YourNum) 
20 25 30 35  
20 25 30  
Number =  25                   

       (c)  Find the output of the following program. 

def Position(C1, C2, C3): 
    C1[0] = C1[0] + 2 
    C2 = C2 + 1 
    C3 = "python" 
P1 = [20] 
P2 = 4 
P3 = "school" 
Position(P1, P2, P3); 
print(P1, ", ", P2, ", ", P3) 
[22] ,  4 ,  school                                                           

 #include int main() { int i; for (i=1; i int main() { int i = 1; while ( i <= 2 ) { printf( "IMS Ghaziabad\n"); i = i + 1; } } 

#include void main() { int a = 10, b=100; if( a > b ) printf( "Largest number is %d\n”, a); 

• Make sure that all words are spelled correctly. 
• Try different keywords. 
• Try more general keywords. 
• Try fewer keywords. 
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